Sue Harper
SQL Developer Data Modeler

Dan Hotka
Oracle Trace Facility

Cary Millsap
Method R - An Interview

Jed Walker
Configuring Data Guard for Physical Standby Part II

Board Focus - Tim Gorman
Member Focus - Debra Addeo
The PL/SQL Challenge

“Destined to Become World Famous”

Why? Just listen to what people are saying:

◆ "The quiz is fantastic – great learning opportunity – and now you can see past quizzes and their results even better. well done." - From Andre
◆ "Cool quiz to tickle the brain!" - From A.M.
◆ "The PL/SQL quiz is one of the highlights of my workday. Thank you for creating a professional culture for us PL/SQL developers!" - From Lauren
◆ "The PL/SQL Challenge has quickly become my caffeine companion in the mornings to help get the grey matter moving and the synapses firing. Even if I don't feel very intelligent after seeing some of the correct answers..." - From Matt G

But wait! There’s more!
- Win fabulous prizes!
- Become the envy of your peers!
- Did we mention the fabulous prizes?

Play today! Play tomorrow. Heck, if you travel fast enough you can play yesterday!

The Challenge is simple: you play the quiz - daily. We keep score. You get ranked. Every three months, the top-ranking players compete in a quarterly championship to award first, second and third prizes. But that's not all! Every week and month, players win prizes based on the correctness of their answers and from participation raffles. The more you play, the greater your chance of winning.

So what are you waiting for?
It's time to take the PL/SQL Challenge!
To register and play, or for more information, visit www.plsqlchallenge.com.

www.plsqlchallenge.com
Contents

Features
6 Quick Guide To Configuring Data Guard
   by Jed Walker
   Oracle 11gR2, Part 2 of 2
12 Method R
   by Cary Millsap
   An Interview With Cary
15 Open World 2010
   by Brad Blake and Carolyn Fryc
   Two Perspectives
16 Oracle SQL Developer
   by Sue Harper
   Data Modeler
16 Oracle Trace Facility
   by Dan Hotka
   Part II

Departments
22 RMOUG Membership Focus
   Debra Addeo
24 RMOUG Board Focus
   Tim Gorman

Monthly Features
4 Letter From The President
4 From The Editor
5 Stan Yellott Scholarship Fund
26 Membership Application
27 Advertising Rates
28 RMOUG Board of Directors
30 RMOUG Calendar of Events
31 November 2010 QEW
31 Index To Advertisers

A special Thank You to Heidi Kuhn and Peggy King, without whose continuing help, this publication would not be possible.

On the Cover:
Lisa Collett, a native Coloradoan from the Western slope, enjoys photography on the side of a professional technical position. She travels world-wide, taking pictures along the way, and is also active in taking senior portraits.

BE MORE THAN A DATABASE TECHNOLOGIST.
BE AN INFLUENTIAL DATABASE TECHNOLOGIST.

> Who would have thought you could cultivate influence like you cultivate a garden. By applying the academic definition of database management to the pockets of knowledge hidden in an inner-city neighborhood, one database technologist is growing a strong community in her own backyard.

Regis University’s School of Computer & Information Sciences does more than prepare the adult learner for a successful career. But it also teaches a rigorous core curriculum that provides the critical thinking and creative problem-solving skills you need to positively change the lives of those around you.

You can pick from several of our well-structured and competitive degrees that combine technical knowledge, theory, and practice to make you a valuable asset in an ever-changing business world. Your expertise will have no expiration date. And you can apply it across technologies, industries, or even to the fruit and vegetable world. Experience the power of influence.

COLORADO · NEVADA · ONLINE > 1.800.659.6810 > CPS.Regis.edu/beinfluential > Read more online

> Join us for an upcoming Information Session or Webinar.
Hiking through the changing Aspens last weekend reminded me how quickly time passes and this year is no exception. With 2011 right around the corner, your Conference Committee is busy preparing for the Training Days Conference.

The 2011 Training Days Conference will be at the Colorado Convention Center in Denver. The conference will begin on Tuesday, February 15, 2011 in a newer part on the convention center, the 300 and 400 halls, with the informative four hour (½ day) in-depth University Sessions. The conference keynote presentations and technical sessions are scheduled for Wednesday, February 16, 2011 through Thursday, February 17, 2011.

With an overwhelming response to this year’s call for papers, the 2011 Training Days Conference promises to continue the long standing RMOUG tradition of providing a conference packed full of exceptional presentations and numerous opportunities to share knowledge and hear the latest information about product development. Right now, the Training Days Conference committee is busy reviewing presentation abstracts submitted from around the world. The selection of papers and scheduling will conclude toward the end of October. So look for the Training Days 2011 Preliminary Conference agenda to be posted to the RMOUG website (www.rmou.org) around the middle of November.

And keep an eye on your email in early November for the RMOUG Training Days 2011 Announcement that registration is open. Remember to spread the word to your co-workers – “Register early for Training Days 2011 to take full take advantage of the Early Registration discount. It just makes the conference even a better value.”

If you are interested in helping on the committee or as an ambassador at Training Days; please let Ron Bich (trainingdays-dir@rmou.org) or Heidi Kuhn (admin@rmou.org) know so they can send you details.

Looking forward to seeing everyone in February...

Peggy King
2009/2010 President

Here’s hoping our greetings from RMOUG finds you healthy and happy. I’ve had some great feedback from a few of you about the magazine and would love to hear from all of you. Please email NewsletterDir@rmou.org with any comments or suggestions. This is your magazine!

I’ve been reading a great book, Shift, by Gary Keller. Although aimed at the real estate industry, Gary has some excellent advice for any business owner who finds themselves a little overwhelmed by the recent turns in the economy. Here’s an excerpt from the book, with Gary’s advice about mindset:

“I believe that your life will be either about your problems or your opportunities. You’ll either be running away from something or running toward something. It’s your call. To survive a shift you must first make the mental shift to run towards what you most want and avoid the temptation of running away from what you most fear. One approach lifts you up and the other drags you down. You must keep both eyes on your target and not the ever moving market. Remember that success is never about the chosen few, but always about the few who choose. You get to choose and your life builds from there.

There are three types of people who emerge when a market shifts. First, those that fearfully predict the worst and are unnecessarily pessimistic; second, those who hopefully wish for the best, believe they can’t fail, and are unrealistically positive; and, third, those who respect the fact that they might fail, actively prepare for the worst, and strive for the best. These are the resourcefully realistic and are always the timely triumphant. They are matter-of-fact about the market and sensible about their situation. They see things as they are and openly acknowledge how they’re doing. At the same time they stay optimistic about their opportunities. As my friend Zig Ziglar says ‘they do a checkup from the neck up’ and make sure that even though the market is reshaping itself it isn’t reshaping their attitude.’

So, if the market, and especially the media, has you down, simply pick yourself up, dust yourself off and start all over again. And, if you’re curious about why I’m reading a book on real estate, well, that’s a story for another time.

Happy Trails,
Pat Van Buskirk
Stan Yellott Scholarship Fund

Application
Call for Winter Applications
Submission Deadline is October 29, 2010

The Rocky Mountain Oracle User's Group (RMOUG) is committed to supporting others in their pursuit of technical knowledge. Since 2001, the RMOUG Scholarship Fund has provided funds to encourage future IT professionals in their efforts to broaden their knowledge.

In 2007, RMOUG voted to rename the scholarship fund to honor the memory of Stan Yellott. A long time member of RMOUG, Stan supported the user community by serving on the Board with a focus on expanding educational opportunities. Stan took this commitment beyond colleagues by including high school and college students, the next generation of IT professionals.

The Stan Yellott Scholarship Fund will honor Stan's good work by assisting deserving students to attain their IT educational goals. Scholarships are awarded to students interested in pursuing studies related to Information Technology.

Eligibility Requirements:

- Registered or the intent to register at an accredited post secondary educational institution in the United States
- Minimum GPA 2.5 from a current official transcript
- Currently enrolled in a computer science/information technology class and/or intends to enroll in a computer science the following term

For details visit the RMOUG website at www.rmoug.org and click on the Scholarship tab.

If you are interested in contributing to the scholarship fund, please contact Heidi Kuhn

HeidiKuhn@rmoug.org

By contributing to the Stan Yellott Scholarship Fund, you are joining with RMOUG and the Information Technology Community to assist deserving students to achieve their IT educational goals. For contributions of $100 or more, you will receive a commemorative Tie-Dyed T-Shirt in honor of Stan.

Be Sure To Attend The Fall Quarterly Education Workshop

November 19, 2010

RMOUG is seeking abstracts for this meeting. Presentations may include overviews, tips, techniques, testimonials, and lessons-learned. For abstract submission, we are seeking the equivalent of a proposal for the presentation.

If you or your company are interested in sponsoring breakfast for the workshop, please see page 11 for rates.

Sponsor the next QEW and receive an ad in SQL>Update at HALF the normal price.

Please contact Carolyn Fryc
cfryc@orsportal.com

Check www.rmoug.org for the location, times and featured speakers

Stan Yellott Scholarship Fund

Call for Winter Applications
Submission Deadline is October 29, 2010

The Rocky Mountain Oracle User's Group (RMOUG) is committed to supporting others in their pursuit of technical knowledge.

Since 2001, the RMOUG Scholarship Fund has provided funds to encourage future IT professionals in their efforts to broaden their knowledge.

In 2007, RMOUG voted to rename the scholarship fund to honor the memory of Stan Yellott. A long time member of RMOUG, Stan supported the user community by serving on the Board with a focus on expanding educational opportunities. Stan took this commitment beyond colleagues by including high school and college students, the next generation of IT professionals.

The Stan Yellott Scholarship Fund will honor Stan’s good work by assisting deserving students to attain their IT educational goals. Scholarships are awarded to students interested in pursuing studies related to Information Technology.

Eligibility Requirements:

- Registered or the intent to register at an accredited post secondary educational institution in the United States
- Minimum GPA 2.5 from a current official transcript
- Currently enrolled in a computer science/information technology class and/or intends to enroll in a computer science the following term

For details visit the RMOUG website at www.rmoug.org and click on the Scholarship tab.

If you are interested in contributing to the scholarship fund, please contact Heidi Kuhn

HeidiKuhn@rmoug.org

By contributing to the Stan Yellott Scholarship Fund, you are joining with RMOUG and the Information Technology Community to assist deserving students to achieve their IT educational goals. For contributions of $100 or more, you will receive a commemorative Tie-Dyed T-Shirt in honor of Stan.

Please contact Carolyn Fryc
cfryc@orsportal.com

Check www.rmoug.org for the location, times and featured speakers
Introduction

Data Guard is an Oracle feature that primarily provides database redundancy. This is done by having a copy or standby database, preferably in another location and on separate disk. This standby database is maintained by applying the changes from the primary database to it. Standby databases can be maintained with either Redo (Physical standby) or SQL (Logical standby).

My intention with this paper is primarily to show that configuring Data Guard is not complex, and does not require any special skills or training to accomplish. Part I of this paper walked you through creating a basic Data Guard configuration. In this part I will walk you through switchover, failover (database and client), and other items. My hope is that if you're new to Data Guard, just considering it, or worried that it is too hard to setup, that this paper will help you through the process and get you up and running.

If you find mistakes, additional important notes or considerations, please let me know.

Previously

In Part I of this paper (Vol. 59, SQL<Update), we got a physical standby Data Guard configuration running. In this part I will cover switchovers, failovers, client failover, rebuilding using Flashback database, Active Data Guard, and a small discussion on backups.

Configuration For Failover

First, we'll create the failover supporting service on the database. This involves creating the service, making sure it is started on the primary database, and making sure it is always running on only the primary database. The way I have done this is to create an additional service name for the clients to connect to. This allows you to connect to any specific database you want to, but also connect to the primary when that is what you want. This is how we create the service with SQL:

```
begin
    DBMS_SERVICE.CREATE_SERVICE (service_name => 'JED_RW',
                                    network_name => 'JED_RW',
                                    aq_ha_notifications => TRUE,
                                    failover_method => 'BASIC',
                                    failover_type => 'SELECT',
                                    failover_retries => 30,
                                    failover_delay => 5);
/
```

This service is setup to send failover notifications to clients, and allow for SELECT queries to continue if a failover occurs. I use the naming convention of SID_RW to indicate that this is a Read/Write database (the primary). The reason I do this is for clarity of purpose when using Oracle Active Data Guard. I'll talk more about that later.

Next we need to make sure this service is always running on the Primary, but not on the Standby. To do that we create a procedure that starts the service if the database is primary and stops the service if it is standby.

```
create or replace procedure cmc_taf_service_proc
is
    v_role VARCHAR(30);
begin
    select DATABASE_ROLE into v_role from V$DATABASE;
    if v_role = 'PRIMARY' then
        DBMS_SERVICE.START_SERVICE('JED_RW');
    else
        DBMS_SERVICE.STOP_SERVICE('JED_RW');
    end if;
end;
/
```

Next, we create two triggers to run the procedure on database startup and on role change. Documentation I've found only mentions creating a trigger for role change in 11g, but if you bounce your database it won't restart the failover service. This is why I create both.
Now that we have that in place, execute the procedure to make sure the service is running and archive the current log so the changes make their way to the standby.

Now that we have that in place, execute the procedure to make sure the service is running and archive the current log so the changes make their way to the standby.

We now have a service name of JED_RW that clients can use to connect to.

We now have a service name of JED_RW that clients can use to connect to.

Having this service name available isn’t enough though. You must also configure your client’s TNS Names entry (or other connection method) to support this. The client TNS Names entry should appear as follows:

```
JED_RW =
  (DESCRIPTION_LIST=
    (DESCRIPTION =
      (ADDRESS_LIST=
        (ADDRESS = (PROTOCOL = TCP)(HOST = dev-db1.cmc.
          cable.comcast.com)(PORT = 1521))
        (ADDRESS = (PROTOCOL = TCP)(HOST = dev-db2.cmc.
          cable.comcast.com)(PORT = 1521))
      )
    )
  )
CONNECT_DATA = (SERVICE_NAME = JED_RW)

JED =
  (DESCRIPTION_LIST=
    (DESCRIPTION =
      (ADDRESS = (PROTOCOL = TCP)(HOST = dev-db1.cmc.
        cable.comcast.com)(PORT = 1521))
    )
  )
CONNECT_DATA = (SERVICE_NAME = JED)
```

Once your client connects using this new net service name, they will be able to follow along when a switchover or failover occurs. If the client is running a query and has no DML in a transaction then their work will continue normally, with a delay, as long as the switchover or failover completes prior to the last retry (you should experiment with switchover and failover so your RETRIES and DELAY settings will be appropriate). If they have a transaction in progress they will be connected to the new primary, but they will get an error (e.g. ORA-25402: transaction must roll back), and will have to issue a rollback.

If your database is up and running, but you get “ORA-01033: ORACLE initialization or shutdown in progress” then it is likely you are trying to connect to the standby database. Check your TNS net service name entry carefully to make sure you have it configured for the “RW” service name.

### Performing a Switchover

If you’ve made it to this point then things are looking good. Now you’re ready to do a switchover, but there are a few checks you should perform before you start. First verify there are no redo gaps, by querying the primary:

```
SQL> select STATUS, GAP_STATUS from V$ARCHIVE_DEST_STATUS where DEST_ID = 2;
```

You should get VALID and NO GAP to proceed.

Verify that temporary files on the standby match those on the primary by querying v$logfile and checking at the file system.

Remove any settings you added to your LOG_ARCHIVE_DEST_N parameters to delay apply of redo logs on the standby – you want to have everything applied for a good switchover (no data loss). Then, verify that all available redo has been applied to the standby, by querying the standby:

```
SQL> select NAME, VALUE, DATUM_TIME from V$DATABASE_STATS;
```

There should be no “transport lag” or “apply lag”, and “finish time” should be zero.

Having checked those pre-requisites, verify that the primary is ready to be transitioned to a standby, by querying the primary:

```
SQL> select SWITCHOVER_STATUS from V$DATABASE;
```
If you see TO STANDBY or SESSIONS ACTIVE then it is ready. So, switch the primary to standby role:

```
SQL> alter database commit to switchover to physical standby with session shutdown;
SQL> shutdown immediate;
SQL> startup mount;
```

Next, you need to verify the standby can be switched to primary role, by querying the standby:

```
SQL> select SWITCHOVER_STATUS from V$DATABASE;
```

If you see TO PRIMARY or SESSIONS ACTIVE then you are ready. If you see SWITCHOVER LATENT or SWITCHOVER PENDING then check the alert log for any issues. Usually it just needs to apply some redo. If that is the case, run the following on the standby:

```
SQL> recover standby database using backup controlfile;
```

You should see SWITCHOVER PENDING from the previous query while it applies. When complete you should see TO PRIMARY or SESSIONS ACTIVE.

You can now switch the standby to primary role:

```
SQL> alter database commit to switchover to primary with session shutdown;
SQL> alter database open;
```

Now that you have completed the switchover, be sure to start Redo Apply on the standby:

```
SQL> alter database recover managed standby database using current logfile disconnect from session;
```

If your clients are configured correctly they should failover to the new database. I’ll cover this later.

**Performing a Failover**

Failover is used when the primary database is either lost or not able to function correctly and service must be restored. A failover converts a standby database into a primary, but unlike a switchover does not change the role of the primary (it is not functioning). When a failover is done you must recreate the primary, or using Flashback Database, roll it back to a point-in-time prior to the event, and then convert it to a standby and start redo apply.

I have classified failover into three categories: Graceful, Almost Graceful, and Standard. The category that is used is dependent on how bad the failure of the primary is, and no, a failover isn’t graceful but how you do it can be. Start with Graceful and work your way to Standard to ensure the best failover (in regards to how much data you will lose, or not lose). Note that these are not Oracle terms for failover, I made them up to represent the three phases I see if performing a failover.

**Failover - Graceful**

If the standby is in maximum protection mode it must be switched to maximum performance mode in order for you to do a failover. To change this:

```
SQL> alter database set standby database to maximize performance;
```

Now, if you can mount the primary database, you can try flushing any unsent redo to the standby. If you can do this, it is possible you can failover without any data loss. Note that in this example we recently did a switchover to JED2, so we are now failovering over to JED.

Try this:

```
SQL> startup mount
SQL> alter system flush redo to ‘JED’;
```

If this works and the redo is transported you will still need to apply it all. Now continue to “Failover – Almost Graceful” to make sure all redo is available at the standby.

**Failover - Almost Graceful**

To avoid losing as much data as possible you should try to get all archived redo logs applied. To do this you should copy over any archived redo logs from the primary to the standby. It is possible some of these may already be at the standby, but if you do this you can be sure you have as much redo as possible. Then you will need to resolve any gaps in the redo on the standby.

First, copy all archived redo log files to the standby and then register them with the database:

```
SQL> alter database register physical logfile ‘&logfile_path_name’;
```

Then check for any redo gaps:

```
SQL> select THREAD#, LOW_SEQUENCE#, HIGH_SEQUENCE# from V$ARCHIVE_GAP;
```

If any gaps exist and the files are available on the failed primary then copy those log files across from the appropriate thread and register them as previously shown.

**Failover - Standard**

Stop managed redo apply by issuing this on the standby:

```
SQL> alter database recover managed standby database CANCEL;
```

```
Finish applying any redo:

```
SQL> ALTER DATABASE RECOVER MANAGED STANDBY DATABASE FINISH;
```

If you receive any errors on this you’ll need to examine the trace/alert information. Once you’ve run this command you cannot return this database to a standby, it must become a primary or be recreated.

Now verify the standby can be switched to primary, by running the following on the standby:

```
SQL> select SWITCHOVER_STATUS from V$DATABASE;
```

You should get TO PRIMARY or SESSIONS ACTIVE from this query. If so you can continue, if not, you probably have not finished applying all redo. Be sure you ran the RECOVER ... FINISH command.

You can now failover your standby to primary:

```
SQL> alter database commit to switchover to primary with session shutdown;
SQL> alter database open;
```

If you have other standby locations you might need to restart Redo Apply at those locations. Your next step is to rebuild the old primary as a standby. If you have Flashback Database configured, then you can use that to make this task easier.

**Rebuild Using Flashback Database**

Now that you’ve had to failover to your standby, you need to create a new standby from your old primary. To rebuild your old primary as a new standby using Flashback Database you first need to get the SCN at which the old standby became the new primary. To find this you can query the new primary:

```
SQL> SELECT to_char(STANDBY_BECAME_PRIMARY_SCN) from V$DATABASE;
```

With the SCN in hand, you can now use Flashback Database to return your old primary to the point-in-time the switchover occurred. On the old primary:

```
SQL> SHUTDOWN IMMEDIATE;
SQL> STARTUP MOUNT;
SQL> FLASHBACK DATABASE TO SCN &standby_became_primary_scn;
```

If you did not have Flashback Logging turned on then the command will fail with “ORA-38726: Flashback database logging is not on.” and you will not be able to flashback. Instead you will need to recreate the database as a standby from the new primary.

```
SQL> ALTER DATABASE CONVERT TO PHYSICAL STANDBY;
SQL> SHUTDOWN IMMEDIATE;
SQL> STARTUP MOUNT;
SQL> ALTER DATABASE RECOVER MANAGED STANDBY DATABASE USING CURRENT LOGFILE DISCONNECT FROM SESSION;
```

Now that the old primary is at an SCN that can be used to recover from the new primary’s redo, you can convert it to a physical standby database and start the Redo Apply process.

Now perform a log switch and verify Redo Apply is working using the previous instructions.

**Client Failover**

Something I really love is that the clients can automatically reconnect when you do a switchover or failover. Try the following example on your system and watch the results. For this example, I have JED as my primary database and JED2 as my standby database. The client has connected using the failover capable JED_RW net service name.

First, connect a SQL*Plus client to the primary database using JED_RW as the SYSTEM user and see where you are connected:

```
CLIENT> connect system@jed_rw
CLIENT> select db_unique_name from v$database;
```

You should see JED. Now perform the switchover steps up to the point where you commit the standby to being a primary with the “alter database commit to switchover to primary with session shutdown;” command. At this point both your standby and primary are in the MOUNT state. Try your query again:

```
CLIENT> select db_unique_name from v$database;
```

The result should be what appears to be a hang. This is because your client is currently making attempts to find the primary database, but there currently isn’t a primary database available. Now, go ahead and complete the switchover process.

When the process is complete your client should reconnect and re-issue the query. When it does your query should complete and return JED2 because the primary is now the JED2 database, not the JED database. Another cool way to watch this happen is to start a very long running query and start the switchover just after the results start scrolling in your session. You should notice the results pause and then restart when the switchover or failover is complete.

**Active Data Guard**

Warning! Active Data Guard is a separately licensed feature. So while it is easy to turn on you should not use this without licensing.
Active Data Guard is a new feature in Oracle 11g that allows you to have a physical standby open for read operations while at the same time actively applying redo. It is quickly apparent why this is such a great feature. The ability to have a physical (not logical) copy of your primary database that you can backup and read from while keeping it current is a very nice advantage. Oracle knows this too, and so it is separately licensed.

The great thing about Active Data Guard is how easy it is to activate. It is simply a matter of opening your standby database and then starting Redo Apply.

### SQL Commands

```
SQL> STARTUP MOUNT
SQL> ALTER DATABASE OPEN;
SQL> ALTER DATABASE RECOVER MANAGED STANDBY DATABASE USING CURRENT LOGFILE DISCONNECT;
```

You can now login and run select queries from the database. You can also verify this with the following query:

```
SQL> SELECT name status, database_role, open_mode logins, log_mode FROM v$instance, v$database;
```

In Active Data Guard mode you should see PHYSICAL STANDBY, READ ONLY WITH APPLY, and ARCHIVELOG.

Another change you’ll want to make if you run Active Data Guard is allowing users to connect to the “correct” database for their needs, wherever it is. For this, I create a second service called SID_RO and run it only on the Standby database. This indicates that you are connecting to the Read Only standby database, not the Read Write primary. This is done the same as the SID_RW service was:

```sql
begin
  DBMS_SERVICE.CREATE_SERVICE (service_name => 'JED_RO',
                              network_name => 'JED_RO',
                              aq_ha_notifications => TRUE,
                              failover_method => 'BASIC',
                              failover_type => 'SELECT',
                              failover_retries => 30,
                              failover_delay => 5);
end;
/
```

You then need to modify your procedure for starting/stopping the services, so that it starts the correct service:

```sql
create or replace procedure cmc_taf_service_proc
is
  v_role VARCHAR(30);
begin
  select DATABASE_ROLE into v_role from V$DATABASE;
  if v_role = ‘PRIMARY’ then
    begin
      DBMS_SERVICE.STOP_SERVICE('JED_RW');
    exception
      when others then null;
    end;
    DBMS_SERVICE.START_SERVICE('JED_RO');
  end if;
end;
```

You now have an Active Data Guard configuration, and your clients can connect to the appropriate instance with the ability to re-connect upon a switchover or failover.

### Backup

Finally, a discussion of Data Guard wouldn’t be complete without some discussion of backups. Data Guard is essentially a backup, but that does not mean you can go without your RMAN backups. You’ve taken the time to force all redo to be logged, so you might as well do some backups too!

With Data Guard and RMAN you can perform your backups on the primary or standby database, but since you have a physical standby you might as well take that load off of your primary. In general, the standard backup commands (and scripts) you use on the primary will work on the standby, but there are some catches that you should be aware of. These are documented in the Oracle documentation and I will just mention a few key things:

- You should use a Recovery Catalog. This is because the primary will need to be aware of what backup files are available on the standby. Also, you do not need to register the standby with the catalog, the catalog will recognize it as a standby.
- You cannot backup the standby control file, so don’t turn off backups completely on the primary. At the least backup your control file and spfile.

With that said, backup and recovery could be a whole paper, so I’m just going to review how I set up my backups to get you started and then you can use that, or modify it, or come up with your own strategy. Please be sure you test that you can recover from whatever you implement.

On the primary I still back up the archived logs. First, by having archived logs on the primary and standby it gives me two locations where archived logs are stored (redundancy). Second, in the event I had to do some recovery (offline data file, etc) I have logs available on the primary already. The catch of course is that I need to remove them at some point to free up disk space. So, running an archivelog backup on the primary is required. Given that we need to use a recovery catalog, I create a global script for this:

```sql
create global script dg_primary_arch
{
  backup archivelog all delete all input;
delete noprompt obsolete;
}
```
On the standby I run my standard backup of the database and archivelogs and remove the old obsolete backups. Again, I use a global script:

```sql
create global script dg_standby_full
{
  backup database plus archivelog delete all input;
  delete noprompt obsolete;
}
```

Another useful technique is to use a shared filesystem for your backups if possible. That way you have visibility to the backups from both servers. In the event you need to do a recovery on your primary you do not have to copy over the backup files first. Note that in this case you will have two copies, but on the same file system, so a disk failure could cause the loss of both copies.

**Conclusion**

Oracle 11g Data Guard is a very nice feature that can be configured relatively easily and that provides the ability for the system to failover in the event of an outage on the primary database. It also offers the ability to offload backups to your standby thereby reducing the load on your primary database. In addition Oracle Data Guard Broker is a tool that claims to make all of this much simpler and easier to manage, but that is something for another paper.

---

Jed Walker is the Manager of Database Operations for the Comcast Media Center in Centennial Colorado. He has been working with Oracle Databases since 1997 and is an Oracle Certified Professional for 9i, 10g, and 11g Database.

---

**SPONSOR A QUARTERLY EDUCATION WORKSHOP AND RECEIVE A HALF PRICE AD IN SQL>UPDATE**

<table>
<thead>
<tr>
<th>Breakfast</th>
<th>Discounted Ad Rate</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/4 Page</td>
<td>$350.00</td>
<td>$525.00</td>
</tr>
<tr>
<td>1/2 Page</td>
<td>$350.00</td>
<td>$662.50</td>
</tr>
<tr>
<td>Full Page</td>
<td>$350.00</td>
<td>$850.00</td>
</tr>
<tr>
<td>Inside Cover</td>
<td>$350.00</td>
<td>$975.00</td>
</tr>
<tr>
<td>Back Cover</td>
<td>$350.00</td>
<td>$1,100.00</td>
</tr>
</tbody>
</table>

*Contact Carolyn Fryc - Programs Director - 720-221-4432 - cfryc@orsportal.com*
Cary Millsap is the founder and president of Method R Corporation, a small business that builds and optimizes software all over the world. Cary specializes in software optimization. He is the author of *Optimizing Oracle Performance* (O’Reilly 2003), for which he and Method R colleague Jeff Holt were granted the Oracle Magazine Author of the Year award. He has presented at hundreds of conferences and courses worldwide, and he is also published in *Communications of the ACM*. Cary spent the 1990s as a consultant and leader of consulting teams within Oracle Corporation. In 1999, Cary resigned as vice president of Oracle’s System Performance Group to start a career as a business owner.

Today, we interview Cary about his company’s new software tool called Method R Trace.

**Recently, you shipped a new tool for collecting Oracle trace data. Tell us about it.**

We’ve built a new tool called “Method R Trace,” which we call “Mister Trace” for short [Ed. note: spelled “MR Trace,” where “MR” is short for “Method R”). It’s an extension for Oracle SQL Developer. Its purpose in life is very simple: to completely eliminate all of the distractions associated with getting your hands on perfectly scoped Oracle extended SQL trace data.

**Why did you choose Oracle SQL Developer?**

Oracle SQL Developer is a great choice foremost because so many application developers out there are using it. The number of downloads of Oracle SQL Developer in the market is just crazy. It’s millions. So it’s a huge market potential for us. It has a great open API, and it also gives us the advantage of being truly multiplatform, so we don’t have to waste time on porting. We have a single MR Trace source code base in Java, and it runs everywhere. Plus, it’s Oracle. Our friends there on the SQL Developer product team have been very good to us.

**What kind of trace data does MR Trace collect? Is it Oracle’s 10046 trace data?**

Yes, exactly. It’s the 10046 level 8 trace data where the Oracle kernel emits one line per database call (the *parse*, *exec*, and *fetch* lines) and one line per operating system call (the *wait* lines). This gives you a complete history of exactly how the Oracle kernel has spent your response time. It also gives you the execution plans that Oracle used to execute your queries. ...Which, I might add, are always your actual execution plans. That’s important, because a lot of developers rely on *explain plan*, which doesn’t always give you the plan that Oracle actually uses.

**Why did you focus on 10046 trace data instead of, for example, Oracle’s Active Session History (ASH) data?**

Several reasons. First, MR Trace is targeted primarily at application software developers. These are people who typically don’t have access to Oracle’s V$ views or the tools that DBAs usually use, like Oracle Enterprise Manager. Their access to performance data is almost always restricted.

Second, even if you had access to all the V$ and X$ data in the world, it’s extremely difficult to make sense of it all. The extended SQL trace data is much easier for a developer to use, because it’s simply a call-by-call record of everything the Oracle kernel has done in response to the code that you’ve written. There’s only one file format to learn, and with trace files you don’t have to spend your time guessing whether something “interesting looking” that happened on the system has anything to do with the code you just wrote. Everything in that trace file is work that your code did.

Finally, ASH is available only if you’ve purchased Oracle’s Diagnostics pack. Not everyone has access to ASH data, but everybody running Oracle 7 or beyond can use Oracle’s extended SQL trace data—regardless of whether you’re using Exadata, or Enterprise Edition, or Standard Edition, or even Oracle XE.

**Do developers have access to trace files?**

That’s a big problem at a lot of shops: developers don’t have access to their trace files. There’s almost never a carefully thought-out policy to prevent them from having access. It’s usually just inertia: it’s not much fun to set up a secure way for developers to grab their trace files, and most DBAs have way too much on their plates to spend a few days thinking up elegant solutions to a problem like that. Some of them are too busy fixing performance problems that
might have been prevented had their friends in development had access to their trace data!

MR Trace ends the drama of a developer having to call up a system administrator or a DBA to ask for a trace file. If you've ever tried to get your trace data, you know how messy it is: you have to turn trace on and off at exactly the right times, log into your database server host—or ask your DBA to do it for you, if you're not allowed in there—grope around for the trace file you want, and then copy it back to your workstation where you're writing your code. It's a lot of steps and a huge distraction, especially if you have to negotiate with humans for access every time you need a file. Nobody likes it.

With MR Trace, you have a brief one-time conversation with your DBA when you install it. After that, it's simply a matter of doing your normal thing. Every time you use the “Run Script” feature in SQL Developer with MR Trace turned on, your trace file just shows up. It's all automatic. No extra typing. No extra clicks. Your mind never leaves the job you're supposed to be focused on. MR Trace is the easiest tool to demo that we've ever made. If you've ever done the fetch-the-file-yourself routine, it just drops your jaw to see the file show up every time you run something.

We have one customer who uses SQL Developer exclusively for access to MR Trace. And—get this—his Oracle instance runs on his own workstation. He uses MR Trace so he doesn’t have to grope around in his own trace file directory!

How can I see a demo?

We have a 3-minute YouTube video that shows how the whole thing works [http://method-r.com/software/mrtrace]. We also offer a 30-day free trial. It takes practically no time to install MR Trace, and you can see how you like it before you ever commit to buying it or even letting us know who you are.

You mentioned a conversation that you have with your DBA when you install MR Trace. How does that go?

Quite well so far. We're very respectful of your DBA's concerns about security. When you run MR Trace, the software checks whether it has the permissions it needs to operate. If it doesn't, it pops up a dialog showing you exactly the script that your DBA needs to run. If you're your own DBA, you can just enter a username and password, and it'll run it for you. Otherwise, you just cut and paste the script into an email, and now you can negotiate which permissions you'll get. Some of them are optional; a few are required. We've had zero requests to tighten up on the privileges required to run MR Trace so far. I'm very happy about that. However, that's not going to stop us from working to make the privileges even more lightweight and un-intrusive, especially as we add new features.

You recently blogged about the new file delete function [http://method-r.com/blogs/product-blog/147-mr-trace-1020]. Is that your favorite feature?

It's hard to say that my “favorite” feature is our Delete button, when the product solves such a big nightmare of getting trace files securely from remote database servers. But the way we do file deleting tells you a lot about how we think software should work.

MR Trace is all about staying out of your way. Its entire purpose is to eliminate distraction. Our Delete button used to trigger my emotions in a negative way, because it didn’t stay out of your way. In MR Trace version 1.0.1, our delete function worked the way my old Windows laptop used to: it popped a modal dialog box asking, “Are you sure you want to delete?” That has always aggravated me. You want to delete a file. You've pressed the button. Now your software has jumped between you and the work you need to be doing, with this nagging dialog that forces you to read something, compute an answer, and then respond with a click. Software that does that drives me nuts. I hate it.

So we fixed it. In MR Trace 1.0.2, you press Delete, and it deletes. Simple. Now of course, that’s harder for us to do, because what if you really did click Delete by mistake? We can’t just strand you for making a mistake. But the modal “Are you sure?” dialog technique is just CYA programming. It’s not nice. It’s basically a software designer telling the user, “If this gets screwed up, it’s because you said to. Twice.” So, in 1.0.2, we’ve built a proper multi-level Undo function. If you delete by accident, the software is there to cover for you; you just click Undo. You can get anything back that you’ve deleted since the start of your SQL Developer session.

It’s refreshing for a single Delete click to just do what you’ve asked instead of nagging you about it. That’s how everything we build should feel.

What’s next?

Two things. First, we’re expanding MR Trace’s mission. Today it creates and fetches trace files for you. But what if you want to fetch a trace file that you created yesterday? ...Or a file that someone else created? We’re working on a MR Trace feature that give you a fluid, natural interface for fetching any trace file you want, from any instance your DBA allows.

Second, when that’s done, we’re going to focus more attention on what you do with the trace file once you’ve retrieved it. There’s of course our Method R Profiler, which a lot of people already know about [http://method-r.com/software/profiler]. It gives you a color, 3D click-and-drill view of your response.
time. It’s a mature product that’s been around for almost 10 years now, and it’s extremely well refined. It’s the fastest way to see where your time has gone.

The best-kept secret in our company is our MR Tools suite [http://method-r.com/software/mrtools]. Today, it’s three tools that I use nearly every day:

- There’s mrils, which is like a Unix ls command that can see inside your trace files. You can see, for example, how much response time each of your trace files represents or how many buffer cache touches each file accounts for.
- There’s mrnl, which shows you line-by-line exactly how much time your database calls and syscalls are taking. It does some nice things like convert Oracle’s wacky 1,024-nanosecond microseconds into human microseconds. ...So you don’t have to.
- And finally there’s mrskew. “Mister Skew,” as we call it, is a full-fledged SQL trace file profiler, just like our flagship Method R Profiler product, except mrskew is a lot more flexible and powerful. It’s also quite a bit cheaper than the Profiler.

Today, the only interface to these tools is the command line. Over the coming months, we’ll tie these into the developer’s natural workflow with some very interesting graphical interfaces. Our priority will be industrial strength tools to shred through lots of data really quickly, with fluid and natural interfaces that are a delight to use and that never distract you from your real focus.

---

**Become A Member For These Outstanding Benefits**

- Quarterly Education Workshops
- Special Annual Training Days Rates
- Database Labs
- List Server Subscriptions
- SQL>Update Magazine

[www.rmoug.org/member.htm](http://www.rmoug.org/member.htm)
or
Membership Application on Page 26

---

**REGISTRATION OPENS November 4, 2010**

Take advantage of the Early Registration Discount
Register on or before January 12, 2011
[www.RMOUG.org](http://www.RMOUG.org) | 910.452.0006

**RM OUG TRAINING DAYS**
February 15-17, 2011 | Denver, Colorado
[Colorado Convention Center](http://www.coloradoconventioncenter.com)

THE COLLEGIATE PEAKS PHOTO COURTESY OF JOHN KING, RMOUG MEMBER
OpenWorld 2010 was a busy, action-packed week! San Francisco was buzzing with over 41,000 attendees at this year's conference. As usual, Larry Ellison provided some interesting news in his keynote addresses, and took his usual shots at other companies. The main buzzword this year was “CLOUD”. There were even some jokes at some sessions that the next version of Oracle database will be called Oracle 12C (maybe not a joke?). The new product Larry was pushing is the new “Exalogic” server, which he touted as a “cloud in a box”. He also did a nice job of bashing Marc Benioff and Salesforce.com, arguing that the Salesforce.com definition of a cloud is VERY different from what Oracle believes in. Larry stated that Oracle's stance on cloud computing is in line with what Amazon.com is doing with their EC2 (Elastic Compute Cloud) service.

There was also a big push on the new Oracle Fusion Applications, announcing that there will be 100 modules available by the fourth quarter of this year, with general availability coming early next year.

As far as the technical sessions that were offered, it's always hard to decide what to attend, when there are over 2,000 to select from!! Looking at the developer track, there were a lot of sessions this year on Oracle Application Express (APEX). With version 4.0 recently released, it appears that this tool is really starting to gain some momentum in its acceptance and implementation.

And at the Oracle Appreciation Event, The Black Eyed Peas and Steve Miller Band put on an awesome show!

For me, personally, I always appreciate the chance to get out to OpenWorld. It is a great opportunity to learn, network, and hear from the top Oracle executives. However, most of the sessions always tend to be at a fairly high level, sometimes just sounding like a marketing pitch. For me, as a DBA, I always appreciate a good, TECHNICAL session where I get some actual hands-on tips and tricks of how to do things – something you can take back to the office and USE. For those kinds of sessions, RMOUG Training Days is always a much better “bang for your buck”!

What an event Oracle OpenWorld 2010 was... being that is was the sixth OpenWorld I have attended, this was much better than the last five. With OpenWorld, JavaOne, and Oracle Develop there were three different conferences going on all at the same time. There were tons of sessions, hands on labs, and I believe over 41,000 attendees, not including Oracle Employees. It was a busy few days in San Francisco.

After landing on Tuesday, September 21st, I made it over to the W Hotel for the Users Group Leader Appreciation Luncheon. 100+ leaders from the different users groups in the world attended. I had the opportunity to meet UTOUG, ODTUG, OUAG, IOUG, and OHUG, etc. It was nice seeing how many of us volunteer to help users stay up to date with the latest technologies. I believe there are over 700 different user groups in the world, since Oracle acquired SUN and adding in all the Java groups.

The main reason I attended this year's OpenWorld was to meet up with colleagues from Optima, current clients, potential clients, business partners, Oracle Employees, and look for top talent in some of the latest technologies, in particular ADF (Application Development Framework). And of course, attend the Appreciation event on Wednesday night at Treasure Island. I would have to say the Black Eyes Peas put on an incredible show, even though there were people sitting in the stands. It was amazing.

Now I will wait and see what the next year brings and look forward to Training Days in February 2011.
Capture, Model, Design and Generate Using Oracle SQL Developer Data Modeler

by Sue Harper

Use Oracle SQL Developer Data Modeler to capture your database model, make updates to the model and generate the DDL scripts to create or update your database.

Oracle SQL Developer Data Modeler is a free Oracle product that improves developer productivity by helping users create logical, relational, and physical data models. This standalone tool—available for Windows, Linux, and Mac OS X—supports Oracle databases, Microsoft SQL Server, and IBM DB2. Users can quickly reverse engineer data models from DDL scripts or by connecting directly to the database. It also supports importing models from other tools such as Oracle Designer and CA Erwin Data Modeler. Modeling users can run the design rules to verify the integrity of the models and apply naming standards during transformations. When generating the DDL scripts to create new database objects, there is a wide range of options available to control the output.

Oracle SQL Developer Data Modeler can enhance productivity for database architects, developers, administrators, and end users, on new or existing projects. Modeling facilitates database design and helps architects communicate with clients about business requirements. A visual representation of how tables are linked together can clarify the understanding of user expectations. By easily identifying and addressing inaccuracies in the model early in a project, users prevent costly misunderstandings from occurring later on. Application developers can import the schema they’re working with into Oracle SQL Developer Data Modeler and review the design. When a schema is displayed as a model on a diagram, it’s easy to determine quickly if the design is missing features, such as foreign key relationships between entities. Moreover, developers can run a set of design rules to see if the model complies with a set of standards. DBAs can keep scripts of the schemas they support, import and review the scripts, modify the schemas, and regenerate the scripts—a more productive alternative to verifying and maintaining complete scripts manually.

This column introduces Oracle SQL Developer Data Modeler by taking you on a high-level tour. You’ll build a three-entity logical model, engineer it to a relational model, and generate the DDL. Along the way you’ll see additional Oracle SQL Developer Data Modeler features.

Getting Started

If you don’t already have Oracle SQL Developer Data Modeler installed, download the version for your platform from Oracle Technology Network http://www.oracle.com/technetwork/developer-tools/datamodeler. Expand the file on your local file system and open the \datamodeler folder. On Windows (or the Mac OS X), double-click datamodeler.exe to launch the tool. On Linux, execute datamodeler.sh. To begin modeling in Oracle SQL Developer Data Modeler, you can import DDL scripts directly from a database, import scripts from Oracle Designer or CA Erwin Data Modeler, or—as you’ll do in this column’s exercise—start from scratch by building an entity relationship diagram (ERD). The model we build is based on the Oracle HR sample schema.

Stage 1: Create a Logical Model

The tool opens with both the Logical and Relational model pages open and ready for use. If you close them at any point, or want to open another existing model, right-click the model in the Browser and select Show.

Click the Logical tab to bring it into focus. Click the New Entity button (second from the left) and draw a rectangular shape in the model. As you complete the shape, the Entity Properties dialog opens. Add the following properties:

Name: CUSTOMER
Synonyms: CUST, CUSTS, CUSTOMERS
Synonym to display: CUST
Preferred Abbreviation: CUSTOMERS

Click Apply. This updates the Long Name field in the Entity Properties dialog and adds the entity to the diagram. (Don’t be concerned if it seems strange to use CUSTOMERS as the preferred abbreviation; this will help demonstrate some other features later in the column.) Without closing the dialog, move it to one side so that you can see the entity in the diagram. Notice that it displays the Synonym to display property, not the Name.

Adding Attributes

Click Attributes in the tree on the left side of the Entity Properties dialog. To add an attribute, click the + button, enter values for the Attribute Properties, and click Apply. You’ll notice that the diagram refreshes with each attribute you add.

Add the following attributes, setting the Datatype for each as Logical and selecting the Type from the drop list. Set the Size or Precision specified below:

CUST_ID: Numeric (6). Set this as the primary unique identifier by selecting the Primary UID check box.
CUST_LAST_NAME: Varchar (20) Byte
CREDIT_LIMIT: Numeric (9, 2) Use (Precision, Scale)
CITY: Varchar (25) Byte
TITLE: Varchar (5) Byte

Click OK to close the dialog.
Click the New Entity button and create a second entity using the same process. Enter these details in the Entity Properties dialog:

Name: ORDER
Synonym to display: ORD
Preferred Abbreviation: ORDERS

Add the following attributes with logical datatype settings:
(For the numeric values, set the precision to the value given.)

ORD_ID: Numeric (12). Set this as the Primary UID.
ORDER_DATE: Timestamp with Time Zone
ORDER_STATUS: Numeric (2)

Click OK to close the dialog. Add a third entity called ORDER_ITEM. You need only add ITEM_ID as the primary UID attribute and set the logical datatype to numeric (12).

Adding Relationships
You now have a logical model with three entities and no relationships between them. Click the New 1:N Relation button. Click the CUST entity first and then click the ORD entity to draw the relationship between them. Once the relationship line is drawn, notice that no extra attributes appear to have been added to the ORD entity. Double-click the ORD entity and click Attributes to see the new CUST_ID attribute. You will only see this additional column if you set the CUST_ID column as the Primary UID. Click Cancel to dismiss the dialog.

Whether or not foreign-key attributes should be displayed in ERDs is subject to debate. If you use the Barker notation on your diagram, then they are not displayed; however, because Oracle SQL Developer Data Modeler supports both Bachman, which does display them, and the Barker notations, the foreign-key attribute appears in the properties dialog and is displayed on the diagram when you use Bachman notation.

By default the new attribute's name property is locked. In this example you can leave the current name, but if you needed to change it to comply with naming standards or to clarify the context, you’d follow these steps:

Select Tools -> General Options
Expand the Model node in the tree
Select Logical
Deselect FK Attribute name synchronization

Accept the changes and close the dialog. Now if you return to the ORD entity properties dialog and select the CUST_ID attribute, you can modify the name.

Double-click the relationship to invoke the Relation Properties dialog. Click Cardinality and change the Target Cardinality to mandatory by deselecting the Target Optional check box. Enter may place for the Name on Source and belongs to for the Name on Target, as shown in Figure 1.

Click OK to apply the changes and close the dialog.

Once again click the New 1:N relationship button, this time select the ORD entity first and the ORDER_ITEM second. Double-click the relationship line to invoke the Relation Property dialog for new relationship. Click Cardinality and this time click the Identifying check box. (You could also have done this by selecting the New 1:N identifying relationship button.) The result is that the ORD_ID is now part of the primary unique identifier for the child (ORDER_ITEM) entity. Click OK.

To complete the diagram, go to Tools-> General Options. Expand the Diagram node in the tree and select Logical Model.
Select the **Show Source/Target Name** check box and click **OK**. Your model should now appear as shown in Figure 2. Notice the bar signifying the identifying relationship. If you’d like to straighten the lines in the diagram, as shown in Figure 2, right-click and deselect Autoroute. Now you can select each line in turn and use the context menu to straighten the lines.

**Working with Domains**

Domains are used to specify the datatype for an attribute or column. You can define a domain once and reuse it throughout a model, which is particularly useful when working with large models. For example, you may have an UPDATED_BY column that must appear in each table. You can define an updated_by domain, setting the datatype and size for the domain, and then use this for all tables when using this column. Any changes made to domains are applied throughout the model. Domains are also used for check-constraint details, ranges of valid values, and lists of valid values. These extra details can be used as check constraints in the table definition.

Oracle SQL Developer Data Modeler uses an XML file to store domain settings. Invoke **Tools –> Domain Administration**. Click **Add** to start adding new domains to the default domains file. Enter the following values:

- **Name**: Title
- **Logical Type**: Varchar
- **Size**: 5

Click the **Value List** button and add the values **Mr.**, **Mrs.**, and **Ms.** Click **OK** to save the values and return to the main Domains Administration dialog. Click **Apply** and verify the new domain is now in the list of available domains, then click **SAVE** and **Close**.

In the diagram, double-click the CUSTOMERS entity to invoke the **Entity Properties**. Click the **Attributes** node and select **TITLE** in the attributes list. Under **Attributes Properties**, change the **Datatype** to Domain and expand the list to find and select the “Title” domain. Then double-click the attribute itself. The new dialog displayed is the properties dialog for the attribute. Select **Default and Constraint** from the tree. You can now set the default value for this attribute and specify a name for the constraint, should you choose to implement one. Notice that **Use Domain Constraints** is checked. You can override the values you set for the domain, by deselecting this check box and adding a new set of values here. Enter **Title** in the name, **Sir** as the default value. (Notice that you added a default that is not in the Value List of the domain just created list to illustrate a point later on.) Click **OK** to close the attributes properties dialog.

Repeat the process for the CREDIT_LIMIT attribute: double-click CREDIT_LIMIT in the attributes list to invoke the **Attribute Properties** dialog. Select the **Default and Constraint** node, and then uncheck **Use Domain Constraints**. Click the blank **Constraint** button. Double-click the **Generic Constraint** field to edit it. Enter **credit_limit <= 5000** and click **Apply**. If you have different constraints for different databases, you can add them to the specific database here; depending on the database selected during DDL generation, the appropriate constraint is created. Close both open dialogs by clicking **OK**.

**Stage 2: Engineer to a Relational Model**

You are now ready to forward-engineer the model. Click the **Engineer to Relational Model** button in the toolbar. In the dialog that appears, you can select the objects you want to include in the process. For this exercise, you want to engineer all objects.

You need to verify one option. Expand the **Entities** node and observe the entity and table names listed. Click the **General Options** tab and select the **Apply name translation** check box. Expand the **Entities** node again and notice that the preferred abbreviation values you set now display in the table list, as shown in Figure 3. Click the **Engineer** button to generate your relational model.

**Reviewing the Engineered Properties**

Double-click the CUSTOMERS table to invoke the **Table Properties** dialog. Select the **Columns** node in the tree and double-click **TITLE** to invoke the **Column Properties** dialog. Select the **Default and Constraint** node. Verify that default value is **Sir** and enter **Title** as the **Constraint Name**. Click **OK** to close each dialog and then right-click the CUSTOMERS entity in the diagram. Select **DDL Preview**. The output includes the following pieces of code.

```sql
CREATE TABLE CUSTOMERS
(
    CUST_ID NUMBER (6) NOT NULL,
    CUST_LAST_NAME VARCHAR2 (20),
    CREDIT_LIMIT NUMBER (9,2) CHECK ( credit_limit <= 5000 ),
    CITY VARCHAR2 (25),
    TITLE VARCHAR2 (25) DEFAULT ‘Sir’
);

ALTER TABLE CUSTOMERS
ADD CONSTRAINT Title
CHECK ( TITLE IN (‘Miss’, ‘Mr’, ‘Mrs’ ) )
;
```

Click **Close**.

**Using Design Rules**

SQL Developer provides an extensive set of Design Rules. Using the model created you can see these Design Rules in action. Select...
Tools -> Design Rules. In the tree, expand the Relational node and the Column node under that. A number of rules are displayed here. With the Column node selected, click Apply Selected. You should see a red bar displaying an error for Title. The default value you set (Sir) did not match the set of permitted valid values. If you double click on the red error message, you are taken to the Column Properties dialog, where you can select the Default and Constraint node and modify the default value. Change the value from ‘Sir’ to one of the values in the domain list, such as ‘Mr.’ and accepting the update, you can return to the Design Rules and reapply the selected Column section. The red error message is removed.

Stage 3: Add the Physical Model

You can generate the DDL script at this stage, but the Data Modeler also supports physical database structures and properties. Here you look at how you can start to take advantage of them. Expand the Relational Models node in the browser. Expand Relational_1 and select Physical Models. Right-click, select Open from the context menu, select Oracle Database 11g, and expand the new Oracle Database 11g node. You can see all the physical aspects of the database that you can set. You can create multiple physical database models for your single relational model, enabling you to produce different DDL scripts for each.

Select and right-click the Users node and select New in the context menu. Add a new user named Personnel. You need not complete the rest of the dialog, but you can see that a number of database properties are available to set for creating new users. Click OK.

Now expand the Tables node and right-click the CUSTOMERS table to select properties. Update the User property by setting it to Personnel and click OK. Although you can do much more with this feature, for the purpose of this example, you are now ready to generate the DDL scripts.

Stage 4: Generate the DDL scripts

To invoke the DDL Generation Options dialog you can either click the Generate DDL button in the main toolbar or select File -> Export -> DDL File. If you have defined multiple physical models, then you can select the correct physical model from the database list. For this example select Oracle Database 11g (the default). Click Generate. This populates the dialog with all possible values available for generation. Do not click OK now; doing so would generate all the objects defined in the physical model listed, because they are all selected by default.

Click the check box next to the top-level Oracle Database 11g node to deselect all the other nodes. Expand the Assigned to User node. Keep expanding it until you see the tables. Note that CUSTOMERS is the only table listed here. Click the check box next to Assigned to Users, which selects all the nodes below, including the CUSTOMERS table. Now expand Not Assigned To Users and expand the Tables node. The other two tables you created are listed here, as shown in Figure 4, because they have not been associated with any specific schemas. Check the ORDER_ITEMS and ORDERS tables.

Click the Tables tab to see the tables now selected for generation. Click OK to start the generation. The script displayed reflects the objects you chose. Once you have finished the generation, save the script to a file.

Reverse Engineering and Updating the Database

In the preceding steps, you created a small data model by starting with a blank sheet of paper. The flow described above mimics, in very small part, the way you might start creating a new model from scratch. However, this is not the only approach. Many developers don’t start with a logical (or conceptual) model, preferring to start by drawing the tables and adding in the columns and constraints. Oracle SQL Developer Data Modeler supports this approach by allowing you to start by drawing the relational model and moving on from there. You can also start by reverse engineering the model from a DDL script or directly from the database, by creating a new connection to the database and importing the schema or indeed, multiple schemas, directly from the database.

If you create a model in this way, you can make changes to the model and the database and have SQL Developer Data Modeler compare and merge the changes. In this case you need to determine whether the model needs to update the database, or the database needs to update the model. Whether you are updating the database, importing a new model or bringing updates from the database to merge changes into the model, you need to use the File -> Import menu. The dialog provides the option to merge the models or to produce the DDL to update the database.

Conclusion

Oracle SQL Developer Data Modeler is a free graphical data modeling and design tool, which provides a rich set of utilities to help you build standards driven data models. The SQL Developer Data Modeler supports domains, glossaries, templates and a rich set of Design Rules that can be used during the modeling and design phases. In this column you were introduced to one possible Oracle SQL Developer Data Modeler workflow, by starting with a blank diagram and creating an entity relationship diagram, to expose a few of the features and to illustrate some of the ways in which this tool can boost your productivity. Visit the Oracle Technology Network to download the product and learn more about Oracle SQL Developer Data Modeler.
Oracle Trace Facility
By Dan Hotka

Part II – Trace File Analysis Tools

The Oracle Trace Facility was introduced in/around Oracle7. This useful tool collects SQL statements, their associated bind variables, and the wait events (work they caused Oracle), along with a variety of useful statistics...for an individual session, another session, or the entire database.

In prior issues, I discussed how to create trace files (I illustrated my scripts that start/stop trace for your session and other sessions...scripts available on my website). This series of articles will discuss:

- TOAD Trace File Analysis
- Metalink Tool: Trace File Analyzer
- Metalink Tool: SQL T

SQL T

SQLT (SQLTXPLAIN) is a tool that inputs one SQL statement and outputs a set of comprehensive diagnostic files for SQL performance analysis and tuning.

***Note*** These notes are from the SQLT user documentation

Comprehensive HTML report that includes an enhanced explain plan, details about the tables accessed by the SQL, their indexes, their columns, CBO statistics including Histograms, partitions and subpartitions if applicable, initialization parameters in effect, stored outlines associated to the SQL, SQL profiles if any, child plans, metrics of SQL execution performance, observations, etc.

SQL T is available via Metalink note 215187.1. Download SQLT.zip and follow the directions to install it.

***Tip*** Run the tool using a SYSDBA account! More information will be available to the output.

Since the tool is installed into its own schema and makes use of temporary objects for most of its data structures, it is light and moderate intrusive. The schema owner SQLTXPLAIN only gets granted a small subset of roles and attributes in order to generate SQL analysis results. This SQLTXPLAIN schema owner does not read application data itself.

- This SQLT tool installs into its own schema
- It does not install any objects into application schemas
- Its footprint is very small
- The RDBMS version can be 9i, 10g or 11g
- The OS can be UNIX, LINUX or WINDOWS
- Source is not wrapped (SQL and PL/SQL)
- It can be installed in RAC systems
- It installs by executing just one script sqcreate.sql

SQLT inputs one SQL DML statement provided as one of these methods:

1. XPLAIN: As a stand-alone SQL in a flat text file.
2. XTRACT: As a memory-resident SQL, identified by its hash_value or sql_id.
3. XECUTE: As a stand-alone script that contains one SQL, together with the declaration and values of its bind variables.
4. XTRXEC: As a combination of XTRACT and XECUTE, this method gets a SQL from memory and executes both XTRACT and XECUTE.

The recommended methods are XECUTE and XTRACT. Try avoiding the XPLAIN method since the Explain Plan generated by it may not be accurate if your SQL contains bind variables.
SQLT runs various traces and collects information from a variety of sources including AWR. This is the main.html doc... everything is hyperlinked and all information about this SQL statement is included.

Summary

The Oracle Trace Facility is useful to capture problem SQL for later review. If a problem can be recreated, or, a time can be specified when a particular issue occurs, then the Oracle Trace facility can be used to capture the problem SQL. Tools like SQL T creates a nice comprehensive report that covers all aspects of a SQL statement from a file or SQL identity in Oracle memory.

Dan Hotka is a Training Specialist and an Oracle ACE Director who has over 32 years in the computer industry, over 27 years of experience with Oracle products. His experience with the Oracle RDBMS dates back to the Oracle V4.0 days. Dan’s latest book is the TOAD Handbook by Pearson.

Instructor-Led Training At Your Desk!

Classroom style training over the web is available today. This is a new and exciting training format which fits into your busy schedule.

Web-Based Oracle Training by Dan Hotka:

- Morning Lecture Sessions (half days)
- Hands-on Labs
- Cost effective – includes all course materials

Advanced PL/Sql
- October 25-27, 2010 - Minneapolis, MN

TOAD for Developers
- October 29, 2010 - Minneapolis, MN

Sql Tuning for Developers
- November 15-17, 2010

Visit Dan’s web site for course outlines or email Dan with your level of interest. Dan also provides all of his course offerings for your company both over the web or on-site at a low course-fee (on-site course guides priced per student).

Contact Dan at:
www.DanHotka.com
Dhotka@Earthlink.net - (515) 279-3361

RMOUG Training Days
February 15-17, 2011
Colorado Convention Center

VOLUNTEER
Room Ambassadors and Registration Assistants Needed

Visit www.rmoug.org/training.htm

Share your knowledge and experience with other Oracle professionals

HAVE QUESTIONS?
303-948-1786 or email TrainingDaysDirector@rmoug.org
I could sit down and write 1000 lines of code without any problem. Take those same letters and write a 1000 word article is quite a bit different. I will warn you that I am a very boring person so read this article when you are in need of sleep. Being a person of very few words this is going to be a challenge.

Work History...

Sometimes the best laid career plans don’t seem to prepare people for where they end up. My BS degree is in Chemical Engineering. When I graduated college the chemical and petroleum industry was in a recession. I worked with industrial and specialty gases for my first five years out of college. The specialty gases were quite hazardous and some of the gases could cause death by the time you smelled them. After a while, I came to the conclusion that is not what I wanted to do with the rest of my life. So I went back to college to get an MBA degree and work in finance. Well when I just finished my degree there was another recession, the stock market crashed and of course no jobs. I have really bad timing. While getting my MBA degree it was required that I take IT classes. I was able to get a job doing IT work at a nuclear plant. Ever since that first IT job I never looked back and remained in the field. I started out programming in Cobol, then Ada, then Oracle. I started with Oracle with version 6 of the database and version 3.0 of forms. I have done programming, database administration, web server administration, and E-Business suite. Also I have been both a contractor and a full time employee.

Currently I work with the Identity Management Suite of products. Identity management is a very different world from working with the database. Some days it seems like there are a million parts and pieces that need to be understood to make everything work. Every system is different and needs to be integrated using a different set of rules and an array of different programming languages. I have needed to gain an understanding of LDAP, SQL Server, networking, load balancers and the inner workings of third party programs. In the past few months we have integrated Single Sign On (SSO) with three new systems and each system required a completely new standard for integration. The other challenge with SSO is the integration with cloud computing.

Keeping the repository for username and password management is very challenging. First the data needs to be protected. The data is in the database and encrypted so it is protected. With one logon and password for multiple systems one needs to consider the system with the least amount of security because that is the weak point in the system. For example, if we were to integrate SSO with Google and Google’s repository was broken into and someone stole the usernames and passwords, what damage could that inflict? The data in Google was not proprietary or secret but the person’s password that was stolen also has the ability to access data for another system that does contain information that may be proprietary or sensitive. That is a bigger problem. Sometimes as the administrator you have to say no to SSO or one login and password because it can cause other systems to have security issues. In addition to programming and administration there is now a security hat that needs to be worn to do an effective job. It is difficult to say no to system integration because it would cause other systems to not be as secure. As difficult as it is to say no it would be more difficult to see my name in a newspaper article because I integrated a system and data was stolen or maliciously manipulated. Just remember when different software applications share usernames and passwords the software is only as secure as the least secure system.

When I am not working ...

The last few years I have not been able to volunteer for RMOUG as much as I would have liked. My life has gone in different directions. After the death of my mother, my husband, myself and our dog Luke have spent a lot of time in Arizona rebuilding her houses so that they could be sold. It took us two years to get both houses rebuilt and sold. For us that was quite an accomplishment. When we thought we were done rebuilding houses my husband’s parents moved here from New Jersey. So we had another house that needed to be fixed and prepared for sale. The house in NJ is now sold. Working on houses was a hobby of ours that allowed us to learn with other houses and allows us to apply some of that knowledge to our house. We learned a lot the last few years.

My dog Luke is a nine year old 95 lb black lab Weimaraner mix. We jog or walk...
most days of the week. He ensures that I get my exercise. Also, so there is no confusion here, he does walk me and allows me the illusion that I am in control. I also practice yoga so I can keep up with him.

With all of the time working on houses we have not had as much time for scuba diving. Scuba diving is still a part of my life. After having two collapsed lungs and lung surgery I am still diving. The lung surgery has a 95% chance of keeping my lung from collapsing again. Most people think I am a bit crazy for continuing to dive but my love of diving made it difficult to give up. It has been three years since my surgery and I have not had any problems.

Diving has taken us to the Caribbean, Fiji, Central America, and South America. The world underwater is so different. It is just beautiful and quiet. Being underwater is very relaxing and unlike anything else I have experienced. We have been surrounded by sharks, played with sea lions and dolphins, listened to humpback whales sing under the water, scratched the belly of a manta ray and have been in awe of some of the colors of the coral and fish. Every day diving is a new adventure and you never know what you are going to see.

The part I like best about diving is that there are no phones, computers or anything that resembles work. Diving is my reward for working hard. I can relax, watch the fish and forget about all the things that need to be done in my life. I know that they will be there when I get back.

Ending ...

Those are my 1000 words. It was actually easier than I thought to put them all on paper. In the past articles by members, the member always gave words of wisdom at the end of their article, so here are mine. Life is not always going to take you where you thought and some days you don’t know how you are going to get from point A to point B. No matter where you end up enjoy the journey and make lemonade from lemons.

Debra
I've been in the Information Technology (IT) industry for a lot longer than I had ever imagined. It wasn't a bad choice at all, and I feel fortunate to have stumbled into it. I did not touch a computer until my third year at college, and only then to fulfill the statistics requirement in my major in economics. From that hesitant beginning, it turned out that economics would have been a big mistake, and computers became a desperate "plan B." All in all, it has been a wonderful detour. If anyone asks, I reply that it beats working for a living.

I feel particularly fortunate to have stumbled into this particular niche in IT: databases, Oracle in particular. When I started focusing on databases in the late 1980s, Oracle was an edgy newcomer. Not at all the dominant player it has become, expanding beyond databases to applications to middleware to hardware. Although most in IT feel that databases are just part of the furniture, merely a “persistence layer” underneath applications, I had the opportunity to post my viewpoint on an email discussion forum a few years ago, which was reposted by a colleague to his blog under the title “There's Hope For Us All”...

Back in the 1980s, I worked for a company that had built some really cool applications in the area of travel reservations. Eventually, the travel providers (i.e. airlines, hotels, car rental agencies, etc.) caught on to what we were doing and did it themselves, effectively putting us out of business overnight. So, thus it came time to sell the company off in pieces. We tried to sell the software and code comprising the applications, but nobody wanted them -- they had their own, or could buy or build better. We sold the hardware and facilities, but for pennies on the dollar. Then, when we tried to sell the data, we hit the jackpot -- everybody wanted the data, and we were able to sell it over and over again, to multiple buyers.

I never forgot that lesson, and several years later traded being a programmer for being a DBA because I like working with data. Data, not programs, is the only thing that matters -- applications are transient and have no value except to acquire, manipulate, and display data. Data is the only thing with value. The long-term value of data is the reason I've moved toward data warehousing and business intelligence, too.

Data is important. Databases manage data. DBAs architect, configure, and manage databases. So, being a skilled database administrator will always be necessary as long as data exists. If the state of the art ceases advancing, then automation will finally catch up to extinguish the DBA role/job. But until then, being a DBA is a career.

...and that's my story, and I'm sticking to it, regardless of the latest flavor-of-the-month heralding the death of the database...

Whoop boy! Did those comments cause a storm! Comments like these were posted within hours...

It was probably fairly traumatic to watch the company you worked for quickly go out of business, and would probably lead most people to draw erroneous conclusions from life-changing events going on around you.

Data in a database is worthless in and of itself. It only becomes valuable to the business when an application is available to let the business users view and manipulate the data in specific ways. In the end, it doesn’t matter if that data sits in an rdbms, in xml files, in flat files, comes from web services, whatever, the important thing is the application that exposes the data, often in new and interesting ways.

The data behind Google Maps was there for how long? It was how valuable to a few cartographers? The GMaps application is what counts, not the data.

Well, gee whiz! I wasn’t *born* to this stuff, I arrived at it by watching and listening and considering, and not very casually either. It is interesting to find my conclusions characterized as “erroneous,” when it has worked so well. C’est la vie! Luckily, some smart and obviously well-bred people tended to agree with me in this...

I’m going to have to side with author here. Applications are the conduit, the data is the prize.

Of course, insofar as the application is able to manage the data it is not insignificant. But it is the data that counts. When the data is unique and cannot be re-created/recaptured and for some reason it gets lost, that is when we find ourselves up shite creek without a paddle. An application can be installed again. Unique data is priceless to the point where if it vanishes so does the entity that was supposed to manage it.

It’s even more true with personal data. Stuff you created that can be found nowhere else and can never be recreated. I have never worried about the availability of applications. Applications are a dime a dozen. My data and that in my organization is everything. It does depend on the kind of data of course, something like Google Maps can always generate fresh images. The planet will always be there [or else we’ve got other problems]

You can’t ask your 10-year old to become 2 once more and make that face again. You can’t run that unique test on the batch of user data again when the source data gets lost/corrupted.

It’s data. It truly is.

All hail the database administrator for they are the keepers of the world. And, because I’m not exclusive or naturally hate mongering: a big, wet kiss for our valiant application providers when they manage to create a masterful user experience that allows us to think about the job we’re doing and not the way we’re supposed to fumble with the widgets.

See: everybody gets to win.

Everybody gets to win, indeed! So, I’m happy to be here! Who wouldn’t be? It is a great way to make a living, it allows me to live well in a beautiful part of the world.

I live here in Colorado, where the summers are breathtakingly hot, the autumns are heartbreakingly lovely, and the winters indescribably wonderful. Three-hundred-plus days of sunshine annually tends to spoil a boy. I’ve a 20 year-old son at UC Denver, a 20 year-old stepdaughter at CSU in Ft Collins, a daughter about to graduate Evergreen High School, and a step-daughter setting the world afire at Rock Canyon High School. At the center of my life is my lovely wife Lori, who is a registered nurse (RN) with an MBA, working as a healthcare consultant. Together we scout the area for tasty tequila, tour the Front Range on bicycle, enjoy the ski resorts in winter, and are busy launching our kids as strong, confident, laughing young men and women.

I’ve been involved with the Rocky Mountain Oracle Users Group since 1992 or so, first joined the board in 1995, and have served in most of the board positions since. RMOUG consists of the most impressive people, and you can’t find a nicer bunch of people for whom to present.

I really can’t wait to find out what happens next.

So that’s my story, and I’m sticking to it. Thanks for reading!

Tim
Application For Membership

☐ Individual...$75  ☐ Student (must have Student ID)...$35

Name ________________________________
Company Name ________________________
Address ______________________________
City, State, Zip _______________________
Phone ________________________________
Fax ________________________________
E-Mail ________________________________

Payment Method Total $ _______________
☐ Check/Money Order (Make payable to Rocky Mountain Oracle User’s Group)
☐ Visa Card # _____________________________
☐ MasterCard# ____________________________
Name on Credit Card _______________________

Corporate:

☐ 1-5 Members ____________________________ $300
☐ 6-8 Members ____________________________ $450
☐ 9-12 Members ____________________________ $595

Additional members (over 12) $50 each

Please attach list of all members.

Corporate Contact:

Company Name _______________________
Contact Name ________________________
Address ______________________________
City, State, Zip _______________________
Phone ________________________________
E-mail ________________________________

Please mail completed form and payment to:

Rocky Mountain Oracle Users Group
PO Box 621942
Littleton, CO 80162

FAX: (303) 933-6603

Or Join Online:

http://www.rmoug.org/member.htm

What Is RMOUG?

The Rocky Mountain Oracle Users Group (RMOUG) was established in 1984 with just a few members. Meetings were held twice-a-year to share ideas and information about Oracle. Today, RMOUG is one of the largest Oracle user groups in the world with over 1,000 members.

RMOUG offers general membership meetings, a professional magazine, an annual training event, and an information-packed web site. Members include professional analysts, project managers, database administrators, developers, and designers who work with Oracle products to produce high-quality business solutions.

RMOUG is an alliance partner with the International Oracle Users Group - Americas. RMOUG is a not-for-profit organization incorporated in Colorado.
Reach A Targeted Oracle Audience
Advertise Now!

A full page, full color ad in RMOUG SQL>UPDATE costs as little as 70 cents per printed magazine and even less for smaller ads.

RMOUG SQL>Update Advertising Rates

<table>
<thead>
<tr>
<th>Ad Size</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business card or 1/8 page</td>
<td>$50</td>
</tr>
<tr>
<td>1/4 page</td>
<td>$350</td>
</tr>
<tr>
<td>1/2 page</td>
<td>$625</td>
</tr>
<tr>
<td>Full page</td>
<td>$1,000</td>
</tr>
<tr>
<td>Inside cover</td>
<td>$1,250</td>
</tr>
<tr>
<td>Back cover</td>
<td>$1,500</td>
</tr>
</tbody>
</table>

Discounts available for RMOUG Members and Full Year Contracts

See Media Kit for deadlines and mechanical requirements.
Submit ad materials to: Pat Van Buskirk, RMOUG Newsletter Director
38101 Comanche Creek Road • Kiowa, CO 80117
303-621-7772 • E-mail: NewsletterDir@rmoug.org • www.rmoug.org

SQL>UPDATE is mailed to over 1,000 RMOUG Members and distributed during Quarterly Education Workshops and Training Days each year
RMOUG Board of Directors

Meet Your Board

Peggy King, King Training
President
Business:  (303) 798-5727
Business:  (800) 252-0652
E-mail: President@rmoug.org

John Peterson
Vice President & Treasurer
E-mail: VicePresident@rmoug.org

Allison Leech
Secretary
E-mail: Secretary@rmoug.org

Kathy Robb
Board Member Emeritus
Arisant, LLC
E-mail: Treasurer@rmoug.org

Ron Bich, SofTec Solutions, Inc.
Training Days Director
Phone:  303-650-6951
E-mail: TrainingDaysDir@rmoug.org

Barbara A. Lewis
Membership Director
Axia College of the University of Phoenix
Voice:  303-757-6709
Email: MembershipDir@rmoug.org

Carolyn Fryc
Programs Director
E-mail: ProgramsDir@rmoug.org

Tim Gorman
IS Director
Email: ISDir@rmoug.org

Brad Blake
SIGS Director
E-mail: SIGSDir@rmoug.org

Thomas Green
Scholarship Director
E-mail: ScholarshipDir@rmoug.org

Heidi Kuhn
Administrative Assistant
Voice Mail: (303) 948-1786
Fax:  (303) 933-6603
E-mail: Admin@rmoug.org

Not Pictured
Pat Van Buskirk • Newsletter Director
Email: NewsletterDir@rmoug.org
Ann Horton • Oracle Liaison
Email: OracleLiaison1@rmoug.org
Envisioning A Better Future and Designing Technology To Create It...

✓ Oracle
  • E-Business Suite implementation, upgrades, migrations, and support
  • Fusion Middleware and Open Systems Development
  • Business Intelligence (OBIEE) development
  • Hyperion Financial Performance Management
  • DBA and Database tactical services

✓ IT Infrastructure
  • Managed Services, Remote DBA support, and Hosting (Infrastructure & Applications)
  • BI Rationalization (consolidation) services and tools
  • Security and Identity Management
  • IT Infrastructure Performance, High Availability, and Scalability implementation and support
  • Strategic Global Sourcing

✓ Profitability and Cost Management
  • Budgeting and Forecasting Solutions
  • Operational Intelligence (BI)
  • ERP Business Intelligence
  • Enterprise Performance Management

✓ Rolta Software Solutions
  • iPerspective™ - Rapid development of Enterprise Web Services
  • Geospatial Fusion™ - Enterprise Spatial Integration and Visualization
  • OneView™ - Business and Operational Intelligence

<table>
<thead>
<tr>
<th>Date</th>
<th>Event</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>10/22/10</td>
<td>QEW</td>
<td>QEW - Deadline for Presentations</td>
</tr>
<tr>
<td>11/1/10</td>
<td>Newsletter</td>
<td>Newsletter - Call for Articles Winter Issue</td>
</tr>
<tr>
<td>11/5/10</td>
<td>Training Days</td>
<td>Training Days 2011 - Early Registration opens</td>
</tr>
<tr>
<td>11/9/10</td>
<td>Training Days</td>
<td>Training Days 2011 - Speaker confirmation due</td>
</tr>
<tr>
<td>11/15/10</td>
<td>Training Days</td>
<td>Training Days 2011 - Schedule at a Glance Posted to website</td>
</tr>
<tr>
<td>11/16-17/2010</td>
<td>Conference</td>
<td>OAUG Connection Point - Enterprise Performance Mgtt (EPM) - Dallas, TX</td>
</tr>
<tr>
<td>11/19/10</td>
<td>Board</td>
<td>Board Meeting @ 7:00am before first QEW session</td>
</tr>
<tr>
<td>11/19/10</td>
<td>QEW</td>
<td>Quarterly Educational Workshop</td>
</tr>
<tr>
<td>11/19/10</td>
<td>Scholarship</td>
<td>Scholarship - Announce Winter Scholarship recipients at QEW</td>
</tr>
<tr>
<td>11/20/10</td>
<td>Newsletter</td>
<td>Newsletter - Deadline for Articles Winter Issue</td>
</tr>
<tr>
<td>12/2/2010</td>
<td>DB Labs</td>
<td>TBD - Regis University - Denver, Colorado</td>
</tr>
<tr>
<td>12/8/10</td>
<td>Board</td>
<td>Board Monthly Meeting - Conference Call @ 6:00pm</td>
</tr>
<tr>
<td>12/17/10</td>
<td>Newsletter</td>
<td>Newsletter - Mail Date Winter Issue</td>
</tr>
<tr>
<td>1/1/11</td>
<td>Training Days</td>
<td>Training Days 2011 - Speaker Presentation Papers Due</td>
</tr>
<tr>
<td>1/12/11</td>
<td>Training Days</td>
<td>Training Days 2011 - Last day for Early Registration</td>
</tr>
<tr>
<td>1/13/11</td>
<td>Training Days</td>
<td>Training Days 2011 - Standard registration begins</td>
</tr>
<tr>
<td>1/19/11</td>
<td>Board</td>
<td>Board Monthly Meeting - Corporate Offices @ 6:00pm</td>
</tr>
<tr>
<td>2/7/11</td>
<td>Newsletter</td>
<td>Newsletter - Call for Articles Spring Issue</td>
</tr>
<tr>
<td>2/9/11</td>
<td>Training Days</td>
<td>Training Days 2011 - Last day for standard registration</td>
</tr>
<tr>
<td>2/10/11</td>
<td>Training Days</td>
<td>Training Days 2011 - Late Registration begins</td>
</tr>
<tr>
<td>2/15/11</td>
<td>Scholarship</td>
<td>Scholarship - Accepting Applications for Spring Scholarship</td>
</tr>
<tr>
<td>2/17/11</td>
<td>Board</td>
<td>Board Meeting @ Training Days</td>
</tr>
<tr>
<td>2/17/11</td>
<td>Newsletter</td>
<td>Newsletter - Deadline for Articles Spring Issue</td>
</tr>
<tr>
<td>3/2011</td>
<td>DLBLabs</td>
<td>TBD - Regis University Denver</td>
</tr>
<tr>
<td>3/16/11</td>
<td>Board</td>
<td>Board Monthly Meeting - Conference Call @ 6:00pm</td>
</tr>
<tr>
<td>3/22/11</td>
<td>Newsletter</td>
<td>Newsletter - Mail Date Spring Issue</td>
</tr>
<tr>
<td>4/5/11</td>
<td>QEW</td>
<td>QEW - Call for Presentations</td>
</tr>
<tr>
<td>4/10-14/2011</td>
<td>Conference</td>
<td>Collaborate 2011 - Orange County Convention Center - Orlando Florida</td>
</tr>
<tr>
<td>4/22/11</td>
<td>Board</td>
<td>Board Monthly Meeting - Corporate Offices @ 6:00pm</td>
</tr>
<tr>
<td>4/22/11</td>
<td>QEW</td>
<td>QEW - Preliminary Agenda</td>
</tr>
<tr>
<td>4/29/11</td>
<td>QEW</td>
<td>QEW - Deadline for Presentations</td>
</tr>
<tr>
<td>4/29/11</td>
<td>Scholarship</td>
<td>Scholarship - Deadline for Applications for Spring Scholarship</td>
</tr>
<tr>
<td>5/2011</td>
<td>DLBLabs</td>
<td>TBD - Regis University - Denver, Colorado</td>
</tr>
<tr>
<td>5/3/11</td>
<td>Newsletter</td>
<td>Newsletter - Call for Articles Summer Issue</td>
</tr>
<tr>
<td>5/20/11</td>
<td>Board</td>
<td>Board Meeting - 7:00am before first QEW session</td>
</tr>
<tr>
<td>5/20/11</td>
<td>QEW</td>
<td>Quarterly Educational Workshop</td>
</tr>
<tr>
<td>5/20/11</td>
<td>Scholarship</td>
<td>Scholarship - Announce Spring Scholarship recipients at QEW</td>
</tr>
<tr>
<td>6/3/11</td>
<td>Newsletter</td>
<td>Newsletter - Deadline for Articles Summer Issue</td>
</tr>
</tbody>
</table>

Please note dates are subject to change. For the most current events calendar visit our website at www.rmoug.org.
Join us for our next Quarterly Education Workshop in August at the Regis University Science Amphitheatre. RMOUG hosts quarterly workshops in May, August and November of each year with the fourth and largest educational event being Training Days in February. Learn about the newest technologies, gain more insight into Oracle techniques and enjoy the camaraderie of meeting with other Oracle professionals.

If you or your organization are interested in partnering with RMOUG to host an upcoming meeting, or to submit an abstract for presentation, please contact Carolyn Fryc, Programs Director at ProgramsDir@rmoug.org

Watch RMOUG’s Web Page for November Training Topics

www.rmoug.org
More information is coming soon to www.rmoug.org.